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About this Book and the Library

The User Site User Guide provides conceptual information about the NetIQ VigilEnt Policy Center (VPC) 
product. This book defines terminology and various related concepts. This book also provides step-by-step 
guidance for many User Site tasks.

Intended Audience
This book provides information for individuals who need to use the VPC User Site to read company 
policies, take quizzes, and perform related tasks.

Other Information in the Library
The library provides the following information resources:

User Guide

Provides conceptual information and step-by-step guidance for common Administration Site 
tasks. 

Web Services Guide

Provides information for VPC administrators and internal development teams responsible for 
implementing VPC Web Services in their organization.

Help

Provides conceptual information and step-by-step guidance for using the VPC Administration 
Site and the VPC User Site.

Tutorials

Provide interactive training for common VPC tasks performed in the Administration Site.
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Conventions
The library uses consistent conventions to help you identify items throughout the documentation. The 
following table summarizes these conventions.

Convention Use

Bold • Window and menu items
• Technical terms, when introduced

Italics • Book and CD-ROM titles
• Variable names and values
• Emphasized words

Fixed Font • File and folder names
• Commands and code examples
• Text you must type
• Text (output) displayed in the command-line interface

Brackets, such as [value] • Optional parameters of a command

Braces, such as {value} • Required parameters of a command

Logical OR, such as 
value1|value2

• Exclusive parameters. Choose one parameter.
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About NetIQ Corporation

NetIQ, an Attachmate business, is a global leader in systems and security management. With more than 
12,000 customers in over 60 countries, NetIQ solutions maximize technology investments and enable IT 
process improvements to achieve measurable cost savings. The company’s portfolio includes award-
winning management products for IT Process Automation, Systems Management, Security Management, 
Configuration Audit and Control, Enterprise Administration, and Unified Communications 
Management. For more information, please visit www.netiq.com.

Contacting Sales Support
For questions about products, pricing, and capabilities, please contact your local partner. If you cannot 
contact your partner, please contact our Sales Support team.

Contacting Technical Support
For specific product issues, please contact our Technical Support team.

Contacting Documentation Support
Our goal is to provide documentation that meets your needs. If you have suggestions for improvements, 
please email Documentation-Feedback@netiq.com. We value your input and look forward to hearing 
from you.

Contacting the Online User Community
Qmunity, the NetIQ online community, is a collaborative network connecting you to your peers and 
NetIQ experts. By providing more immediate information, useful links to helpful resources, and access to 
NetIQ experts, Qmunity helps ensure you are mastering the knowledge you need to realize the full 
potential of IT investments upon which you rely. For more information, please visit http://
community.netiq.com. 

Worldwide: www.netiq.com/about_netiq/officelocations.asp

United States and Canada: 888-323-6768 

Email: info@netiq.com

Web Site: www.netiq.com

Worldwide: www.netiq.com/Support/contactinfo.asp

North and South America: 1-713-418-5555 

Europe, Middle East, and Africa: +353 (0) 91-782 677

Email: support@netiq.com

Web Site: www.netiq.com/support
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Chapter 1
Working in the User Site

The VigilEnt Policy Center (VPC) User Site includes several options to make it easy for you to use. If your 
document administrator sets certain permissions, you can create your own account, modify the account 
information, change your password, report a policy violation or security incident, and change the 
language in which VPC displays your Home page. 

VPC offers some tasks only if your administrator enables the option for your use. These tasks are 
indicated as (optional). 

User Computer Requirements
Access to the User Site requires user computers to have one of the following Web browsers installed:

• Internet Explorer 6.0 through 8.0

• Netscape 7.0

• Firefox 1.0 through 3.5

To view and use most VPC features, you can use a supported version of Netscape or Firefox. However, to 
review and edit Microsoft Word documents using ActiveX controls, you must access VPC through 
Internet Explorer. Although Firefox and other browsers that work on multiple operating systems use the 
Netscape Plugin Application Programming Interface (NPAPI) system, which performs functions similar to 
those of ActiveX, Firefox does not officially support ActiveX. 

If your account is set to allow you to review policy documents, ensure your computer meets the following 
additional requirements for reviewing policy documents on the User Site:

• To review policies in PDF format, you must have Adobe Acrobat Reader 6.0.1 or later installed on 
your computer..

• To review policies in Microsoft Word format:

- Microsoft Word 2003 or 2007 must be installed 

- Screen resolution must be set to 1024 x 768 pixels or more

- Local intranet security settings in Internet Explorer must be set to download, run, and script safe 
ActiveX controls as shown in the following table.

Setting Permission
Download signed ActiveX controls Prompt

Download unsigned ActiveX controls Disable

Initialize and script ActiveX controls not marked as safe for scripting Disable
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About the Home Page 
VigilEnt Policy Center displays the Home page when you log on to the User Site. The Home page shows 
the last logon date and time, if available, the New Policies list, New Quizzes list, Search Policies field, and 
the News box. 

Under New Policies and New Quizzes, VPC displays the policy documents and quizzes posted by your 
document administrator that you have not read. The News box displays items from the document 
administrator and often conveys security news and information on a new policy document or quiz. 

The Home page also provides icons to the following options, if enabled: Home, My Documents, Search 
Policies, Report an Incident, My Information, Help, and Log Off. For more information about the 
function of each option, see “User Site Options” on page 2. 

User Site Options
The right side of the User Site title bar has several icons to help you access common tasks. Place your 
cursor over an icon to see the name of the option it represents. VPC displays these options depending on 
the page you are viewing and whether you have permissions to perform the function. the following table 
shows the User Site icons and what function each icon performs.

Changing the Default Language (Optional)
If you are more comfortable reading the User Site in an alternative language, you can select an available 
language in which to view information. The User Site defaults to the language of your operating system, 
but you can change this setting. Use the following steps to customize the VPC default language and the 
language settings in Microsoft Internet Explorer. 

RunActiveX controls and plug-ins Enable

Script ActiveX controls marked safe for scripting Enable

Icon / Option Function
Account Creation Displays the Account Creation page to create an account.

Home Displays the User Site Home page for the logged-on user.

My Documents Displays the documents available for the logged-on user.

Search Policies Displays a field for searching policy documents.

Report an Incident Displays the Report an Incident page to submit a security incident or policy 
violation.

My Information Displays the My Information page to change any personal information in the 
account.

Help Displays online help for the User Site.

Log Off Logs you off from the User Site.

Setting Permission
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To change the default language for the User Site: 

1. Display the User Site Log On page. 

2. Select the appropriate language from the Language list. 

To change the language setting in Microsoft Internet Explorer: 

1. Open Microsoft Internet Explorer. 

2. Click Tools > Internet Options. 

The computer displays the Internet Options dialog box. 

3. On the General tab, click Languages. 

The computer displays the Language Preference dialog box.

4. Click Add. 

The computer displays the Add Language dialog box. 

5. Click the language to add, and then click OK. 

The computer displays the Language Preference dialog box.

6. Click OK to close the Language Preferences dialog box, and then click OK to close the Internet 
Options dialog box. 

Creating an Account (Optional)
A user account is your key to accessing the User Site. The account, associated with you through a user ID 
and password, is how VPC identifies you and connects you with the features you need within the User 
Site. In some companies, the administrator creates an account for each user; however, you may have the 
ability to create your own account. Use the following steps to create your user account from the User Site.

To create a user account from the User Site:

1. Display the User Site Log On page.

2. Click the Account Creation icon.

VPC displays the Account Creation page.

3. Type the chosen or provided user ID in the User ID field.

4. Type the password in the Password field and confirm by typing the same password in the Confirm 
Password field.

5. Optional. Type your name in the First Name and Last Name fields, and then type your information in 
the E-mail, Department, and Extension fields.

6. Optional. Add your manager to your account by typing your manager’s name in the search field, click 
Search, and then select your manager from the displayed list.

7. Click Save. After you update your account, VPC displays the message Your Account has been 
successfully created.

8. Click Enter to display the Home page.
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Updating Your Personal Information (Optional)
Each user account contains personal information such as your name, electronic mail address, 
department, and telephone extension. This feature lets you change this information. Although some 
companies prevent users from changing account information, you may have access to this feature. Use the 
following steps to update your account. 

To update your personal information: 

1. Log on to the User Site. 

2. Click the My Information icon. 

VPC displays the My Information page. 

3. Make any necessary changes, and then click Update. 

Changing Your Password (Optional)
The User Site lets you change your user account password for any reason. If you believe your password is 
compromised, it is extremely important that you change your password immediately. You may not have 
access to change the password because your password is attached to your personal information. Use the 
following steps to change your password. 

To change your user password: 

1. Log on to the User Site. 

2. Click the My Information icon. 

VPC displays the My Information page. 

3. Click the Change Password icon next to your displayed user ID. 

VPC displays the password change fields. 

4. Type your password in the Current Password field. 

5. Type a new password in the New Password field and confirm by typing the same password in the 
Confirm New field. 

6. Click Save. After you update your account, VPC displays the message Your password has been 
changed. 

7. Click Return. 
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Chapter 2
Reading Policies and Taking Quizzes

One of the major purposes for the User Site is for organizations to post policies and quizzes. Each time an 
administrator publishes a document within VPC, it is available for a period of time on the User Site 
Home page. Once you have read and accepted the document or completed the quiz, VPC removes the 
title from the Home page. If you need to read the document again, you can find it in My Documents. 

Reading a Policy Document 
Procedures and requirements for reading documents vary by document file type. 

• To read policies in Microsoft Word (DOC or DOCX) format, your screen resolution must be set to 
1024 x 768 pixels or more.

• To read policies in PDF format, you must have Adobe Acrobat Reader 6.0.1 or later installed on your 
computer. 

To read a policy document using a Microsoft Internet Explorer browser: 

1. Click the policy document that you want to read. 

- If VPC displays the policy in the Document Reader window, proceed to Step 4. 

- If VPC displays the File Download dialog, your document is in Word file format. Proceed to Step 
2. 

2. Optional. To prevent the File Download dialog from displaying each time you open the editor, clear 
Always ask before opening this type of file. 

3. Click Open. 

VPC displays the policy in the Document Reader window. 

Notes
• If your computer does not meet the appropriate requirements or if you are having issues opening 

or viewing a document, contact your System Administrator.

• You can check the document file type from the My Documents page. If the document file type is 
PDF, DOC/DOCX, or HTML, a corresponding icon shows next to Policy in the Doc Type 
column.

Note
You cannot save changes to a policy document file type from the My Documents page. To add 
comments to a policy, use the Comment pane as described in Step 7.
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4. Optional. Print the document by clicking Print or Printer Help in the upper-right corner, and then 
follow the instructions in the window. 

5. Optional. If the policy exists in multiple language formats, a language selection menu is visible in the 
lower-left corner of the title pane. Select an available language from the options presented.

6. Read the document. 

7. Optional. If the Comment pane is showing, add a comment by first clicking Add. Type a comment in 
the comments area, and then click Submit. 

VPC displays the read-only version of the comment. 

8. Indicate that you have read the document by clicking the approval check box and then clicking 
Submit. 

VPC records the information. 

9. Click Close. 

To read a PDF policy document using Netscape or Firefox: 

1. Click the desired document. 

Based on your browser preference settings, VPC may display the unknown file type dialog box 
because the file is in PDF format. If the dialog box displays, continue with Step 2, otherwise skip to 
Step 7. 

2. In the Enter name of file to save dialog box, for File name, type the name of the policy document. 

3. For Save as type, select *.pdf. 

4. Click Save to save the policy to your hard drive. 

5. Open the Adobe Acrobat Reader. 

6. Click File > Open, and then click the file you just saved to your hard drive.

7. Optional. If the policy exists in multiple language formats, a language selection menu is visible in the 
lower-left corner of the title pane. Select an available language from the options presented.

8. Read the document in the Document Reader. 

9. Click I have read this document and understand its contents to indicate that you have read the 
policy, and then click Submit. 

10. Click Close.

Note
The use of the Title only identifier in the language selection menu indicates the author translated the 
title of the policy but did not provide a translated equivalent of the policy for viewing. The policy 
displays in the primary site language as determined by the site administrator.

Note
The use of the Title only identifier in the language selection menu indicates that the author 
translated the title of the policy but did not provide a translated equivalent of the policy for viewing. 
The policy displays in the primary site language as determined by the site administrator.
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Completing a Quiz
Quizzes help organizations assess employee knowledge of policies. Each time a quiz is published, it is 
available in the New Quizzes list on the Home page. Once you have read and understood the available 
policy documents, you are ready to complete the associated quiz. 

To complete a quiz: 

1. Click the appropriate quiz. 

VPC displays the Document Reader window. 

2. Click the correct answer for each question. 

3. After you have answered all the questions, click Submit. 

VPC displays the score, status, and feedback for each question. 

4. Review the feedback for each missed question. 

5. Optional. If you did not pass the quiz, click Retake Quiz and answer each question again. 

6. Optional. If the Comment pane is showing and you want to include a comment with your quiz results, 
click Add, type your comment, and then click Submit. 

7. Click Close to close the Document Reader window. VPC sends the quiz results to the document 
administrator and moves the policy from the Home page to the My Documents page. 

Searching for a Policy Document
Some companies may have only a few policy documents, but others have hundreds of documents 
available on the User Site. If you need to locate an item quickly, use the search function within the User 
Site. This search eliminates the need to scroll through a list of documents by providing only those items 
matching the search criteria. Use one of the following processes to search for a particular document. 

To search for a policy document: 

• From the User Site Home page, type the criteria in the Search Policies field, and then click Go. VPC 
displays all documents containing the search criteria. Click the Document Title of the policy you 
want to view and VPC displays the policy. 

• From anywhere in the User Site, click the Search Policies icon in the menu bar, type the criteria in 
the Search Policies field, and then click Go. VPC displays all documents containing the search 
criteria. Click the Document Title and VPC displays the policy. 

Viewing Items Unavailable on the Home Page
If the User Site displayed all published policy documents and quizzes within VPC, the Home page would 
be filled with items that you have already read or completed, as well as new items needing your attention. 
VPC alleviates this situation by removing policy documents and quizzes from the Home page once a user 
has read or completed the task. The documents still exist, and you can view them using the My 
Documents icon from the User Site task bar. Use the following steps to access policy documents that you 
have already read or quizzes that you have completed. 
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To view a read policy document or completed quiz:

1. Log on to the User Site.

2. Click the My Documents icon.

VPC displays the My Documents page.

3. Click the policy document or quiz that you want to view.

VPC displays the Document Reader window.

4. Review the document, and then click Close.
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Chapter 3
Reviewing Documents (Optional)

If your account is set to allow you to review policy documents, your Home and My Document pages 
display documents that are in review state. VPC identifies documents in review state by showing a red “R” 
on the document icon. Your thorough review of these documents helps ensure that they are accurate and 
effective. 

Procedures and requirements to review documents vary by document file type. Before you begin a 
document review, verify your computer meets the appropriate requirements. For more information, see 
“User Computer Requirements” on page 1...

To review a document using Internet Explorer: 

1. Click the appropriate document to review. 

- If VPC displays the policy in the Document Reader window, proceed to Step 5. 

- If VPC displays the File Download dialog, your document is in Word file format. Proceed to Step 
2. 

2. Optional. To prevent the File Download dialog from displaying each time you open the editor, clear 
Always ask before opening this type of file. 

3. Click Open. 

VPC displays the policy in the Document Reader window. 

4. Optional. In the Document Reader, right-click the Word toolbar, and then select the Reviewing 
toolbar and any other toolbars necessary to review and edit the document. 

5. Optional. Print the document by clicking Print or Printer Help in the upper-right corner, and then 
follow the instructions in the window. 

6. Optional. Click Properties to view the document author, active date, and other information about the 
document. The Properties button shows only if your administrator has set this option. 

7. If you are not reviewing a Word policy, review the document, and then proceed to Step 8. If you are 
reviewing a Word policy, edit the document and then click Save. 

8. Optional. In the Comments pane, if other reviewers have already commented on the document, click 
View to see the other comments. The View button shows only if your administrator has set this 
option. 

Notes
• If your computer does not meet the appropriate requirements or if you are having issues opening or 

viewing a document, contact your System Administrator.

• You can check the document file type from the My Documents page. If the document file type is 
PDF, DOC/DOCX, or HTML, a corresponding icons shows next to Policy in the Doc Type column.
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9. Optional. In the Comments pane, add a comment by clicking Add, typing your comment, and then 
clicking Submit. 

10. In the Confirmation pane, click the approval checkbox to indicate that you have reviewed the policy, 
and then click Submit. 

To review a PDF document using Netscape or Firefox: 

1. Click the desired document to review. 

Based on your browser preference settings, VPC may display the unknown file type dialog box 
because the file is in PDF format. If the dialog box displays, continue with Step 2, otherwise skip to 
Step 7. 

2. In the Enter name of file to save dialog box, for File name, type the name of the policy document. 

3. For Save as type, select *.pdf. 

4. Click Save to save the policy to your hard drive. 

5. Open the Adobe Acrobat Reader. 

6. Click File > Open, and then click the file you just saved to your hard drive. 

7. Optional. If you are reviewing a policy and you want to print it, click Print in the upper right-hand 
corner, and then follow the instructions in the window. 

8. Optional. Click Properties to view the document author, active date, and other information about the 
document. The Properties button shows only if your administrator has set this option. 

9. Review the document. 

10. Optional. In the Comments pane, if other reviewers have already commented on the document, click 
View to see the other comments. The View button shows only if your administrator has set this 
option.

11. Optional. In the Comments pane, click Add, type a comment, and then click Submit. 

12. In the Confirmation pane, click the approval checkbox to indicate that you have reviewed the policy, 
and then click Submit. 
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Chapter 4
Reporting an Incident (Optional)

Use the Report an Incident form to report policy violations, security incidents, and suspicious activity. 
When reporting incidents, the only required fields are the Type of Incident and Brief Description. 
However, it is best if you include as much information as possible about the incident. Use the following 
steps to report an incident. 

To report an incident: 

1. Display the User Site Log On page or the Home page if you are already logged on to the User Site. 

2. Click the Report an Incident icon. 

VPC displays the Report an Incident page. 

3. Optional. If you want to send the report anonymously, for User ID, select anonymous, and then 
proceed to Step 5. 

4. Optional. Type your phone number, fax number, and e-mail address. 

5. Under Incident Information, for Type of Incident, select the incident type from the list. 

6. For Brief Description, type a summary of the incident. 

7. For Date/Time Details, type the date and time when the incident occurred. 

8. Optional. For Location of Incident, type the location where the incident occurred. 

9. Optional. For Additional Contacts Information, type the names and contact information of any 
other people who may have information about the incident. 

10. Optional. Under Affected System Details, if the incident affects a computer, type the system 
information. 

11. Optional. Under Location of Problem, type the address, room, and building in which the incident 
occurred. 

12. Click Submit. VPC records the information and assigns a tracking number. 

Note
If you report an incident anonymously, after you submit the incident you receive verification that the 
incident was submitted; however, you will not receive any further information about the incident.
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